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Preface

Scope of Manual

This manual describes the RedHawk Architect™, an easy-to-use GUI interface for
creating and maintaining a runtime and development environment for a single board
computer (SBC).

Structure of Manual

This manual consists of:

• Chapter 1, which introduces you to RedHawk Architect and guides you
through its use.

• Chapter 2, which explains Importing ISO Images to avoid repetetive
manual optical media insertion.

• An Index containing an alphabetical reference to key terms and concepts
and the pages where they occur in the text.

Syntax Notation

The following notation is used throughout this manual: 

italic Books, reference cards, and items that the user must specify appear in
italic type. Special terms may also appear in italic.

list bold User input appears in list bold type and must be entered exactly
as shown. Names of directories, files, commands, options and man
page references also appear in list bold type.

list Operating system and program output such as prompts, messages and
listings of files and programs appears in list type.

[] Brackets enclose command options and arguments that are optional.
You do not type the brackets if you choose to specify these options or
arguments.

hypertext links When viewing this document online, clicking on chapter, section,
figure,  table and page number references will  display the
corresponding text. Clicking on Internet URLs provided in blue type
will launch your web browser and display the web site. Clicking on
publication names and numbers in red type will display the
corresponding manual PDF, if accessible.
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Related Publications

The following table lists Concurrent documentation for RedHawk Architect and the
components that can be installed using RedHawk Architect. Depending upon the
document, they are available online on RedHawk Linux systems or from Concurrent’s
documentation web site at http://redhawk.ccur.com/docs.

RedHawk Architect Pub. Number

RedHawk Architect Release Notes 0898600

RedHawk Architect User’s Guide 0898601

RedHawk Linux

RedHawk Linux Release Notes 0898003

RedHawk Linux User’s Guide 0898004

RedHawk Linux Cluster Manager User’s Guide 0898016

RedHawk Linux FAQ N/A

NightStar RT Development Tools

NightView User’s Guide 0898395

NightTrace User’s Guide 0898398

NightProbe User’s Guide 0898465

NightTune User’s Guide 0898515

http://redhawk.ccur.com/docs
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Chapter 1Using RedHawk Architect

1
1
1

This chapter introduces you to RedHawk Architect and provides instructions for its use. 

Introducing Architect 1

RedHawk Architect is an easy-to-use GUI interface for configuring, building and flashing
embedded solutions. 

RedHawk Architect greatly simplifies the following tasks to create and maintain a runtime
and development environment for single board computers (SBCs):

• installing custom configurations of the Red Hat® Enterprise Linux
distribution

• installing and configuring the RedHawkTM operating system

• installing SBC-specific board support packages (BSPs)

• installing NightStarTM RT application development tools

• maintaining and reconfiguring an SBC’s root file system

• flashing the final root file system onto a compact flash device

With Architect, you choose the Linux and application modules that will be installed with
the RedHawk kernel. For example, select networking, web server, web browser, database,
X server, minimal or all packages. Architect allows the Linux file system to be customized
and minimized for embedded applications using flash memories as small as 2 GB.

Architect creates and processes a configuration file based upon your selections and
performs actual RPM package installation. It prompts you to insert the necessary
RedHawk, Red Hat, and NightStar RT media depending upon the features selected.

Creating a root File System for Embedded Target Boards 1

To create a root file system that can be used on a single board computer, use RedHawk
Architect on a supported host system to perform the following steps:

1. Create an image by selecting the software to be installed and building the
image.

2. Configure the image.

3. Customize the image for your embedded application.

4. Flash the image to install it on your target boards.
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These procedures are described in the sections that follow. The steps may be repeated to
change the image and/or flash it any number of times.

Running Architect 1

For instructions for installing RedHawk Architect, refer to the RedHawk Architect Release
Notes.

Architect must be run as the root user. 

To run Architect, type architect at a shell prompt: 

# architect 

Note that the sudo(8) command can alternatively be used to run Architect if that
method is preferred to using a root shell. 

The very first time Architect is invoked after it is installed, a dialog appears presenting you
with the Architect End User License Agreement.

Figure 1-1  Architect End User License Agreement

When Architect starts, a dialog appears presenting you with the option to start a new
session or load an existing session.
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Figure 1-2  Opening RedHawk Architect Dialog

To start a new session, click on the New button. See “Creating a New Session” on page
1-4 for details.

A session can be saved at any time and loaded later to continue work on the file system
image. To edit an existing session, click on the Open button. See “Editing an Existing
Session” on page 1-38 for details.

When the Cancel button is clicked, the RedHawk Architect main window
appears, as shown in the following figure.

Figure 1-3  RedHawk Architect Main Window
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Your choices are:

• start a new session by clicking on the New Session icon  or selecting
New Session from the File menu along the top of the window. See
“Creating a New Session” on page 1-4 for details.

• edit an existing session by clicking on the Open Session icon  or
selecting Open Session in the File menu. See “Editing an Existing
Session” on page 1-38 for details.

Creating a New Session 1

An Architect session describes all decisions made about a particular file system image,
including: 

• the target SBC 

• which software should be installed

• how the software should be configured 

When you select the New button from the opening Architect dialog, or the New Session
icon  or New Session  from the File  menu along the top of the RedHawk
Architect main window, the New Session dialog, shown below, displays.

Figure 1-4  New Session Dialog

This dialog enables you to define the target board and its various characteristics using the
fields described below. 
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RedHawk Release

Specify the version of RedHawk to be used for creating the target file-
system image. Be sure that you have the correct version of the RedHawk
and Red Hat Enterprise Linux media or ISO files necessary to create a
target file-system image of the specified RedHawk release.

Target Board

Specify the target board from the dropdown. Select None  to build a
generic image that does not target any particular board. You may indicate
specific hardware parameters such as root device by using the
Configure Image toolbox.

Root Device

Select the root device to use on the target board from the dropdown. The
choices available depend on the board you have selected.

Root Device Size

Select the size of the selected root device that is installed on your board
from the dropdown. The choices available depend on the board you have
selected.

I/O Expansion

This section shows I/O expansion connectors that are available on the
board you have selected. For each I/O expansion connector, you may
designate an expansion module that you may have connected to it. The
choices available depend on the board you have selected.

OK

Click on this button when all desired selections have been made. This
dialog closes and the RedHawk Architect main window is
activated.

Cancel

Click on this button to cancel any changes made. The dialog closes and you
are returned to the RedHawk Architect main window.

Selecting Software to Install in the Image 1

To select the software to install in the file system image, click on Select Products
from the toolbox on the left side of the RedHawk Architect main window. This
allows you to select software from the following three groups: 

• Red Hat Enterprise Linux packages 

• RedHawk Linux operating system
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• NightStar RT tools

Some initial selections are made for you by default; e.g. the core RedHawk OS.

The Estimated Image Size gauge at the top of the RedHawk Architect
main window indicates the approximate size the file system image will be when built. It
also indicates the percentage of the target board’s root device that will be consumed by the
image. 

Once an image is built, you may click on the Refresh Image Size  button to
calculate the actual image size as it is stored on disk. Alternatively, you may select
Refresh Image Size from the Tools menu. The Estimated Image Size
gauge will be updated to reflect the current actual size.

The spin control box to the right of the Estimated Image Size gauge may be used
to change the desired maximum size of the image. This value cannot exceed the known
size of the root device but it can be made smaller. If the size of the root device is unknown
the maximum value allowed is 1 terabyte.

Selecting Red Hat Packages 1

To select Red Hat Enterprise Linux packages for the file system image, click on the Red
Hat Packages selection from the Select Products toolbox. 

Red Hat packages may be navigated by way of several “Package Views”. Select the
desired package view from the Package Views dropdown. The following views are
available and are described in the subsections that follow.

• Embedded Package Groups 

• Red Hat Package Groups 

• All Packages 

• Selected Packages 

Using the Embedded Package Groups View 1

The Embedded Package Groups  view provides a view of some Red Hat
packages organized into groups. The groups of packages have been optimized for
embedded RedHawk systems and are meant to simplify the task of choosing packages for
common functionality. This view is shown in the following figure.

Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages
may be selected with the Select all packages in group button. 

The Undo button cancels out your last select or unselect operation.
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Figure 1-5  Selecting Red Hat Packages, Embedded Package Groups View

Using the Red Hat Package Groups View 1

The Red Hat Package Groups  view provides a view of Red Hat packages
organized in a hierarchy of groups. The package group hierachy is the standard Red Hat
package group hierachy. This view is shown in the following figure.

Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages
may be selected with the Select all packages in group button. 

The Undo button cancels out your last select or unselect operation.
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Figure 1-6  Selecting Red Hat Packages, Red Hat Package Groups View

Using the All Packages View 1

The All Packages view, as shown in the following figure, provides a linear list of all
Red Hat packages. 
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Figure 1-7  Selecting Red Hat Packages, All Packages View

Packages may be selected or deselected from this list. The Show only packages
matching box allows you to search for packages by name.

All packages can be selected by clicking on the Select all packages button.

The Undo button cancels out your last select or unselect operation.

Using the Selected Packages View 1

The Selected Packages view, as shown in the following figure, provides a linear
list of all Red Hat packages that are currently selected for installation. 
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Figure 1-8  Selecting Red Hat Packages, Selected Packages View

Packages may be deselected from this list.  The Show on ly  packages
matching box allows you to search for packages by name. 

To include the required packages in the list, check the Show required packages
checkbox. When this box is unchecked, only the optional packages are shown.

The Undo button cancels out your last select or unselect operation.

Selecting RedHawk OS Options 1

To select RedHawk Linux OS and kernels for the file system image, click on the
RedHawk selection from the Select Products toolbox. The RedHawk page,
shown in the following figure, displays.
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Figure 1-9  Selecting RedHawk Options

Select which RedHawk kernel(s) to install by checking the appropriate checkbox(es):
Standard , Trace  and/or Debug . The standard kernel does not have tracing or
debugging capabilities and it is the spallest sized kernel option. The trace kernel does offer
tracing capabilities but it does not have debugging capabilities. The debug kernel offers
both debugging and tracing capabilities. Note that at least one kernel must be selected; the
GUI enforces this by ensuring that a sole remaining selection cannot be deselected.

Select Extra kernel debugging features to install extra support for live kernel
debugging. This option is also required for RedHawk to be able to create crash dumps. See
the RedHawk User’s Guide for more information.

Selecting NightStar RT Options 1

To select NightStar RT tools for the image, click on the NightStar RT selection from
the Select Products toolbox. The NightStar RT page, shown in the following figure,
displays.
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Figure 1-10  Selecting NightStar RT Tools

Each NightStar RT tool can be described in brief detail; simply click on each one of the
colorful tool icons to pop up a descriptive dialog window for each tool. 

Click on the Install servers-only radio button to indicate that only NightStar RT
servers are to be installed in the image. You may select individual servers from the list by
clicking on the checkboxes for each tool.

Click on the Install  al l  cl ients and servers  radio button to indicate that
NightStar RT servers and clients are to be installed in the image.

Configuring an Image 1

It is possible to configure a target file-system image before or after the image has been
built by selecting Configure Image  from the toolbox on the left side of the
RedHawk Architect main window. This selection is available before and after an
image is built, however note that there are additional Apply buttons present on the pages
after an image has been built. It is necessary to apply any changes made after the image
has been built in order for the changes to be reflected in the on-disk file-system image.

To configure the file system image, select Configure Image from the toolbox on the
left side of the RedHawk Architect main window. This allows you to configure the
following four groups: 
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• General Settings 

• Console 

• Networking 

• File System

Some initial selections are made for you by default. 

Configuring General Settings 1

To configure time zone, root password and default system run level for the file system
image, click on General Settings from the Configure Image toolbox. The
General Settings configuration page appears, as shown in the following figure.

Figure 1-11  General Settings Configuration Page

In the Time Zone  section, select the proper time zone for your location from the
dropdown. Click in the checkbox to indicate if your system clock uses UTC.

NOTE

If you select the Hardware clock is set to UTC check-
box, be sure to set the target system’s BIOS clock in Coordinated
Universal Time. If you do not select this, set the BIOS clock
according to the selected time zone.
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In the Root Password section, enter the root password in the Password field.
Reenter it in the Confirm Password field. 

In the Run Level section, select the desired default run level from the dropdown. 

If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply General Settings... button to apply the settings to
the image. This button will not appear before the image has been built.

Configuring a Console 1

To configure a serial console for the file system image, click on Console  from the
Configure Image toolbox. The Console Configuration page appears, as
shown in the following figure.

Figure 1-12  Console Configuration Page

Click on the Configure a serial console checkbox to activate the fields that
define the port and baud rate for the console.

Select a port from the Serial Port dropdown.

Select a baud rate from the Baud Rate dropdown.

If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply Console Settings... button to apply the settings to
the image. This button will not appear before the image has been built.
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Configuring Networking 1

To configure networking for the file system image, click on Networking  from the
Configure Image toolbox. The Network Configuration page appears, as
shown in the following figure.

Figure 1-13  Network Configuration Page

All available network devices are listed in the Network Devices section.

To configure a particular network device, click on the device to select it, then click on the
Edit Device Configuration button. The Configure Network Device
dialog shown in the following figure displays.
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Figure 1-14  Configure Network Device Dialog

The selected network device is displayed at the top of the dialog.

Click on the Enabled On Boot checkbox to enable/disable the device automatically
on boot. 

Select Dynamic or Manual address configuration by clicking on the appropriate
radio button. For manual configurations, enter the IP address and netmask in the
appropriate fields.

Click on OK to apply the settings to the image and close the dialog. Click Cancel to
cancel changes.

On the Network Configuration  dialog under the Network Settings
checkbox, either check the Use DHCP  checkbox or supply the hostname, default
gateway, domains, primary and secondary DNS server addresses in the appropriate fields.
Be sure to check the Use DHCP  checkbox if a DHCP server will be providing the
network parameters dynamically.

If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply Network Settings... button to apply the settings to
the image. This button will not appear before the image has been built.

Configuring File System Options 1

To configure file system options for the file system image, click on File System from
the Configure Image  toolbox. The File System Configuration  page
appears, as shown in the following figure.
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Figure 1-15  File System Configuration Page

Indicate the desired root device in the Root Device field.

Select the size of the root device from the Root Device Size dropdown.

Check the Mount with “noatime” option box to mount the root file system with
the noatime option. This helps to minimize the number of writes to the root device when
root is not mounted read-only.

Check the Mount read-only box to mount the root file system read-only. If the root
device is a flash device, this will help preserve the life of the device.

Check the Mount resources listed in /etc/rwtab in tmpfs box to mount
the files and directories listed in /etc/rwtab as writable but temporary files in a tmpfs
file system. This is required to make a read-only root file system work. If root is not
mounted read-only, this option is still useful to help minimize the number of writes to the
root device.

If a change is made to this page after the target file-system image has been built, it is
necessary to click on the Apply File System Settings. . .  button to apply the
settings to the image. This button will not appear before the image has been built.
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Building an Image 1

To build the file system image by installing the selected software, select Build Image
from the toolbox on the left side of the RedHawk Architect main window. The
Build Image page shown in the following figure displays.

Figure 1-16  Build Image Page

Choose a directory in which to build the file system image and enter it in the Target
Directory field, or click on the Browse... button to display a file browser from which
to choose.

NOTE

Do not use /tmp as the image file directory. Packages like “tmp-
watch” might remove files that have not been accessed in a certain
number of days, thereby sabotaging the image directory.

Choose a name for the file system image and enter it in the Image Name field.
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NOTE

Make sure that the directory you specify has enough free disk
space to hold one or more file system images, each of which can
be several gigabytes in size.

Click on the Build button to begin the build process. The rest of this section assumes that
you have not previously imported the ISOs from their respective media by clicking on the
Import ISO Images button or selecting Import ISO Images in the Tools
menu. Advanced users may wish to do that to avoid inserting DVD or CD media
repeatedly. See “Chapter 2: Importing ISO Images” for more information.

Dialogs are presented to guide you through the process of installing the software into the
image. For example, you will be prompted to insert various DVD or CD media, as shown
in the following figure. Follow the directions to load the media, then click OK to begin. 

Figure 1-17  Build Prompt to Insert Red Hat Media

When OK  is selected, the Red Hat installation begins. The Build Image  screen
overlays the RedHawk Architect main window and tracks the progress, as shown
in the following figure. 

Clicking Abort  at any time in the build process aborts the build. A confirmation
message then displays and you must click on the Close button to close the message box
and reactivate the RedHawk Architect main window. 
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Figure 1-18  Status of Red Hat Installation

A progress bar at the top of the Build Image screen shows the progress of the Red Hat
installation from the media.

A status area in the lower half of the screen tracks the progress of the complete build
process. The status area can be changed to show an error log using the View dropdown.

View

When Status is selected, the overall progress messages are displayed.
When Error Log is selected, the error log is displayed, which shows any
error messages generated by the build process. Regardless of the View
setting, critical error messages result in pop-up error dialogs with which
you can interact.

Abort

Click on this button to abort the build. A confirmation dialog displays
allowing you to confirm or decline aborting the build process.

OK

Once the build is completed or aborted, click on the OK button to close the
Build Image  screen and reactivate the RedHawk Architect
main window.
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When the Red Hat installation is complete, the dialog shown in the following figure
appears. 

Figure 1-19  Build Prompt to Insert RedHawk Media

Load the RedHawk Linux media, then click OK. The RedHawk installation begins and
the Build Image screen tracks the progress, as shown in the following figure.

Figure 1-20  Status of RedHawk Installation

When the RedHawk installation is complete, the dialog shown in the following figure
appears. 

Figure 1-21  Build Prompt to Insert NightStar RT Media
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Load the NightStar RT media, then click OK to begin. The NightStar RT installation
begins and the Build Image screen tracks the progress, as shown in the following
figure.

Figure 1-22  Status of NightStar RT Installation

When all software is installed, the completion message shown in the following figure
appears. 
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Figure 1-23  Build Completed Successfully Message

Click OK in the Build Status dialog, then click OK on the Build Image screen to
close it and reactivate the RedHawk Architect main window.

Customizing an Image 1

To further customize the file system image, select Customize Image  from the
toolbox on the left side of the RedHawk Architect main window. This allows you
to customize the following five groups: 

• Kernel Manager

• Additional RPMs

• File Manager

• Chroot Shell

• Image Cleanup

Each of these customizations will be fully described in the following sections.
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Kernel Manager 1

To customize kernel settings for the file system image, click on Kernel Manager
from the Customize Image toolbox. The Kernel Manager page appears, as
shown in the following figure.

Figure 1-24  Kernel Manager Page

The Kernel Manager  allows you to perform different functions with the kernel
configuration in the target image. 

The Kernel to Boot area allows you to choose which installed kernel should be the
default kernel that boots in the target image. Any change made to this setting is
customized in the target image immediately.

The Custom Kernel Operations area contains several different functions related
to configuring and building custom kernels for the target image. These functions will be
described in the following sections.

Note that only one custom kernel configuration, and therefore one custom kernel, can be
associated with a specific target image at any given time.

Configure Custom Kernel 1

The Configure Custom Kernel button begins the process of creating a custom
kernel configuration. The custom kernel configuration is based upon the kernel
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configuration that is selected in the dropdown menu that is immediately to the right of the
Configure Custom Kernel button.

The choices in the dropdown are: RedHawk standard kernel , RedHawk
trace kernel, RedHawk debug kernel and Custom kernel (available
once a custom kernel configuration has been imported or configured). The first three
create new configurations based on the configurations of the standard RedHawk kernels.

The Custom kernel choice bases the new configuration on the current custom kernel
configuration that is associated with the image; thus, the Custom kernel choice can
be used to further customize a configuration that you have already customized or
imported.

Pressing the Configure Custom Kernel button will bring up two different dialog
windows. The first dialog window displays overall configuration progress status, as shown
in the following figure.

Figure 1-25  Custom Kernel Dialog

This window shows the status of running the ccur-config command in the target
image kernel source directory. The ccur-config command will eventually bring up the
Linux Kernel Configuration window to customize the kernel, as shown in the
following figure.
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Figure 1-26  Linux Kernel Configuration Dialog

This window allows you to customize almost any aspect of the custom kernel
configuration. It is expected that users who are performing this step have a thorough
understanding of Linux kernel configuration.

Note that you must Save the kernel configuration before you exit the Linux Kernel
Configuration window. Failure to Save the configuration will result in an error
being displayed in the Custom Kernel Manager dialog window and no changes to
the custom kernel configuration will be made.

NOTE

You may not see the Linux Kernel Configuration Dia-
log appear but instead see an error message similar to the follow-
ing displayed in the Custom Kernel Dialog:

Starting graphical configuration tool...
make[1]: *** No rule to make target
‘scripts/kconfig/.tmp_qtcheck’
make: *** [xconfig] Error 2

If this occurs it means that the qt-devel and possibly qt RPMs
are not installed on the host system (these pacakages are some-
times called qt3 instead of qt). Ensure that these RPMs are
installed on the host system and the errors should disappear.
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Import Kernel Configuration 1

The Import Kernel Configuration button allows you to choose a configuration
file on the host system and import it to become the custom kernel configuration in the
target image.

Note that once a custom kernel configuration has been imported you can further customize
it by using the Configure Custom Kernel button and selecting the Custom
kernel to base the configuration on.

Export Kernel Configuration 1

The Export Kernel Configuration button allows you to copy the target image’s
current custom kernel configuration to the host system.

Build Custom Kernel 1

The Build Custom Kernel  button allows you to build a complete and installed
custom kernel in the target image. You must first have created a custom kernel
configuration, either by using the Configure Custom Kernel button or by using
the Import Kernel Configuration button.

Building a custom kernel compiles each file that comprises the Linux kernel and this
process can take quite a bit of time to complete. Once you start the process, you will see
the Custom Kernel Manager dialog appear, as shown in the following figure and
it will describe the entire process.

Figure 1-27  Initial Build Progress
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Initially ccur-config will be invoked and once that completes the kernel build stages
will begin, as shown in the following figure.

Figure 1-28  Kernel Build Stages

Finally, once the entire build and install process is complete, the kernel source tree will be
cleaned to free up the temporary space used to build the kernel. At this point the entire
build process will be complete, as shown in the following figure.
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Figure 1-29  Kernel Build Complete

The custom kernel automatically becomes the default kernel to boot. If this choice is not
desired, change the kernel to boot using the Kernel To Boot area as described above.

Remove Custom Kernel 1

The Remove Custom Kernel  button allows you to remove the current custom
kernel from the target image. This will remove the entry in grub.conf as well as all of
the associated kernel files in the image.

Note that the custom kernel configuration itself is not removed. Thus, it is still possible to
build a custom kernel based on the current custom kernel configuration that still remains
in the target image.

Additional RPMs 1

To install additional RPMs into the target file system image manually, click on
Addit ional  RPMs  from the Customize Image  toolbox. The Instal l
Additional RPMs page appears, as shown in the following figure.
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Figure 1-30  Install Additional RPMs Page

The Install Additional RPMs page can be used to locate RPM files on the host
system and then easily install them into the target file system image. Note that the
interface supports multiple selection; if you have a set of RPMs that have dependencies
upon each other you will need to select all of the RPMs simultaneously to have them
properly installed together into the target file system image.

Installing Board Support Packages 1

Concurrent provides Board Support Packages (BSPs) for several supported SBCs. These
BSPs are distributed as RPMs that may be installed in an image using the Additional
RPMs page as described above. Contact Concurrent (support@ccur.com or 1-800-245-
6453) for information on how to obtain BSPs for a particular SBC.

File Manager 1

To copy various files into the target file system image manually, click on Fi le
Manager  from the Customize Image  toolbox. The File Manager page
appears, as shown in the following figure.
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Figure 1-31  File Manager Page

The File Manager page supports many features including multiple selection, the
ability to create new directories in the target file system image, and the ability to delete
files in the target system image.

Chroot Shell 1

To customize the target file system image manually, click on the Chroot Shell from
the Customize Image toolbox. The Chroot Shell page appears, as shown in the
following figure
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Figure 1-32  Chroot Shell Page

From this toolbox you can open a “chroot” shell in a terminal window. Select the type of
terminal from the dropdown and click on the Run chroot shell button. A terminal
screen opens, as shown in the following figure.

Figure 1-33  chroot Shell
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This provides a shell with the root directory being the file system image directory. All
changes made to system files (including software installed or removed) will be done in the
file system image directory only. The host’s root file system will not be affected.

Exit the shell when changes are complete.

Image Cleanup 1

You may reduce the size of the file system image by removing various types of files that
may be unnecessary for the image. To remove unnecessary files from the image, click on
Image Cleanup in the Customize Image toolbox. The Image Cleanup
page appears, as shown in the following figure.

Figure 1-34  Image Cleanup Page

Select the types of files to remove from the file system image and click the Remove
selected from image button.

To remove the RPM database from the file system click the Remove RPM
database button. Once this is done you will lose all ability to manage RPMs in the
image. This cannot be undone. Only do this once you are sure you do not have to add or
update any more RPMs in the image.
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Flashing an Image 1

To copy a target root file system image to a CompactFlash device, select Flash Image
from the toolbox on the left side of the RedHawk Architect main window. This
will display the Flash Image page, as shown in the following figure.

Figure 1-35  Flash Image Page

The Flash... button allows you to copy a root file system image onto a CompactFlash that
is connected directly to the host machine via a USB-to-CompactFlash adapter. Note that
IDE/SATA CompactFlash adapters are not supported at this time.

CompactFlash devices can be bought inexpensively at many retail stores that sell
computer accessories. Note that the duration of the flashing process depends upon the
performance rating of the specific CompactFlash device. It is recommended to use
CompactFlash devices that have a minimum of a 40MB/s read/write performance rating.

Pressing the Flash. . .  button will begin copying the target root file system onto the
CompactFlash device by bringing up the Flash Image  dialog, as shown in the
following figure.
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Figure 1-36  Flash Image Dialog

The host system will now be scanned for attached CompactFlash devices. If multiple
devices are found a choice will be presented to the user, otherwise the sole device found
will be selected by default. Once a device is found or chosen, the following confirmation
dialog will appear:

Figure 1-37  Flash Device Confirmation

Press OK to choose the appropriate device, confirm the operation one last time and then
the copy will begin, as shown in Figure 1-38.
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Figure 1-38  Flash Copy Begins

Note that no initial check is made to determine whether the image will fit onto the size of
the selected CompactFlash device. If the copy fails because of insufficient space, an error
message will be displayed, as shown in the following figure.

Figure 1-39  Flash Dialog Error

If the CompactFlash is large enough to hold the image, and no other error occurs during
the copy, a success dialog will be presented, as shown in Figure 1-40.
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Figure 1-40  Flash Copy Completed

Once the copy has completed successfully the CompactFlash can then be placed onto the
intended target board and the board can be reset to boot into a fresh RedHawk installation.

Using Cluster Manager to Deploy an Architect Image 1

RedHawk Linux Cluster Manager provides Architect users with additional methods of
deploying file system images. With Cluster Manager, images may be remotely installed
directly to disk devices on target systems, or target systems may be booted diskless from
an Architect image.

Using Cluster Manager to install Architect images is useful when the root device on the
target system is not a CompactFlash that can be easily removed. The root device may be
any kind of hard disk or solid state device using various interfaces such as IDE, SCSI or
SATA.

Using Cluster Manager to diskless-boot Architect images is especially useful during
development of an embedded application and the file system image. Test systems may be
quickly booted to test each iteration of the file system image. When diskless booting an
Architect image, the image remains in-place where it was built and configured by
Architect. Various services are configured by Cluster Manager to allow target systems to
diskless-boot the image. Multiple target systems may diskless-boot the same image
simultaneously.

To begin using Cluster Manager with Architect images, install Cluster Manager as
described in the RedHawk Linux Cluster Manager User’s Guide, then run the cm-
import command to import an Architect image into Cluster Manager.
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Consult the RedHawk Linux Cluster Manager Evaluation User’s Guide for details on
installing or diskless-booting images.

Editing an Existing Session 1

A session can be saved at any time and loaded later to continue work on a file system
image.

To save the current session click on the Save Session icon  or on Save Session in
the File menu. Selecting the Save As icon  or Save Session As in the File menu
displays a file selection dialog.

NOTE

Performing a Save Session As will not save any associated
image path with the session file. This is useful for cloning ses-
sions to be used to create multiple images. Always use Save
Session if you want the image path to be saved in the session
file.

To load an existing session, click on the Open Session icon  or on Open Session
in the File menu. You may also click on the Open button from the opening dialog when
Architect first starts.

Updating Software Packages 1

Once a target file-system image is built it should boot and run properly. However, it may
be desirable to install the latest RedHawk and NightStar package updates into the image to
receive the latest enhancements and bug fixes.

Follow these steps to install package updates:

1. Make sure that the yum package is selected on the Red Hat
Pa c ka ge s  page of  the S e le c t  Pa c ka g e s  tool  box and
subsequently installed into the target file-system image.

2. Get RPM updates from http://redhawk.ccur.com/updates/home.html

3. Copy RPM updates into the target file-system image directory. For
example:

# mkdir /var/lib/architect/images/test/tmp/updates
# cd /var/lib/architect/images/test/tmp/updates
# cp /home/jason/updates/*.rpm .

4. Use an Architect chroot shell to install updates in the target file-system
image with the yum command. To do this, press the Run Chroot Shell

http://redhawk.ccur.com/updates/home.html
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button on the Chroot Shell page of the Customize Image tool
box and run commands similar to the following:

# yum --nogpgcheck localupdate /tmp/updates/*.rpm
# rm -rf /tmp/updates

At this point all of the downloaded RPM updates should now be properly installed into the
target file-system image.



RedHawk Architect User’s Guide

1-40



2-1

2
Chapter 2Importing ISO Images

2
2
2

This chapter describes how to create or import on-disk ISO images to dramatically speed
up and virtually automate target file-system image creation.

Importing ISO Images 2

Normally when bulding a target file-system image the user is prompted to insert various
optical media discs containing the software that is required in order to create the initial
target file-system image. If only one or two images are being produced, manually inserting
optical media is generally acceptable.

However, if the user is generating and maintaining several different target file-system
image configurations, it is often preferable to create on-disk ISO images of the various
optical media discs. To accomplish this, select the Import ISO Images item in the
Tools menu, or click the Import ISO Images button on the Build Image page,
and the following dialog will appear.

Figure 2-1  Import ISO Images Dialog

There are three different methods that can be used to import ISO images:
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• Import ISO images directly from manually inserted optical media

• Copy ISO images from already existing ISO image files

• Link ISO images to already existing ISO images files

These various methods will be described in the following sections.

The user can import different sets of ISO images for different RedHawk release versions;
use the Release pull-down menu to select which version of RedHawk to import ISO
images for.

In addition, different import methods can be used within a specific RedHawk release. For
example, it is possible to use one import method to import the Red Hat ISO images and a
different import method to import the RedHawk and NightStar ISO images. All
combinations are valid.

Importing ISO Images From Optical Media 2

To use this method select the Rip from DVD or CD import method and then press
the Import button to begin the import process. A dialog similar to the following dialog
will be displayed.

Figure 2-2  Rip ISO Images From Media

At this point the correct optical media disc for the requested item should be manually
inserted into the host system’s optical media tray. Once the optical media has been
inserted, press OK to begin copying the ISO image from the optical media onto the host
system’s hard-drive. Various status messages will be displayed as the copy progresses.
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Copying ISO Images From Existing ISO Images 2

To use this method select the Copy existing file(s) import method and then press
the Import  button to begin the import process. A file selection dialog similar to the
following dialog will be displayed.

Figure 2-3  Copy ISO Image File Selector

Navigate the file selection dialog to the appropriate directory, select the ISO image and
then press the Open button. This will begin the process of copying the ISO image file
into Architect’s /var/lib/architect/ISOs directory. Once the copy is completed,
the ISO image file that was copied is no longer needed and can be removed if necessary.

Linking To Existing ISO Images 2

To use this method select the Symlink to existing files(s) import method and then
press the Import button to begin the import process. A file selection dialog similar to the
following dialog will be displayed.
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Figure 2-4  Symlink To ISO Image File Selector

Navigate the file selection dialog to the appropriate directory, select the ISO image and
then press the Open button. This will immediately create a symbolic link to the selected
ISO image file. The symbolic link will be created and placed inside Architect’s
/var/lib/architect/ISOs directory. Once the copy is completed, the ISO image
file that was linked to must be preserved and kept at the exact same file-system location in
order for Architect’s symbolic link to be valid.

NOTE

Architect will detect if it has symbolic links to ISO image files
that have been erroneously removed and ISO image will no longer
be shown as a valid ISO image in the list of imported ISO images.

If this happens, the ISO image must be imported again to be valid,
otherwise Architect will prompt for the corresponding optical
media disc during any subsequent target file-system image builds.

Deleting Imported ISO Images 2

Previously imported ISO images can be deleted at any time by pressing the Delete
button of the corresponding ISO image. This is not generally necessary, but can be done in
order to save disk space or to recover from the rare case of a file corruption.
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